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1.) What is Quoridor?
Quoridor is a board game in which players must traverse across a board in order to win.  Each player is also given a number “walls” in order to block his opponent, or use in facilitating his path.  Players take turns, and Player 1 goes first.  On a player’s turn, he may either move his given token one space horizontally or vertically, or he may place a wall.  The walls cover the groove between two spaces.  More details about game play can be found in the below sections.  

2.) Rules of Quoridor
There are some rules that govern the classic game of Quoridor, as well as some ones specific to the program.  It should be noted that the Quoridor program prevents any errors from being made.
i.) 2 to 4 players.
ii.) Walls may not overlap each other.
iii.) Walls may only be placed within the grooves of the board.

iv.) Walls may not cut off any player from being able to win.  In other words, there must be at least one possible path for each player to reach their goal, no matter how complex.

v.) Only one token can occupy a space on the board.

vi.) A token can “jump” over another token when adjacent to it.  This means that a token can proceed forward two spaces.  The token may advance to any of the three other spaces around the opponent, provided there is not a wall to that side of the opponent.

vii.) A token may not jump over multiple adjacent tokens.  Only advancing as much as two spaces is permitted.

viii.) A token may not advance into any edge zones except for the target goal zone.
ix.) Any AI player that takes more than 10 seconds to make a move will be disqualified.

x.) A player wins the game by advancing their token across the board to their goal zone.
3.) Setting Up New Games
Once a user launches the game, it will prompt them with an option screen asking if they would like to start a new game, continue a game in progress, or join a game set up by a host computer.  To set up a new game, select “New Game,” and the player setup screen comes up.  A user may set up the information for each player position.  Also this is where a user can change the options of the game.  Basic options include:

The board size (default is 10x10 spaces; range is from 6x6 to 12x12 spaces);

The number of walls each player starts with (can be 0 to 144 per player);

Then the user selects the status of each player.  For up to 4 players, the following choices may be made:  1.) Human;  2.) AI;  3.) Remote User.  After these selections are made, then click “Begin Game” to go to the game board.    

The board appears with the number of player tokens depending on how many players were selected.  Player 1 appears in the bottom starting zone, Player 2 appears in the top zone, Player 3 is on the left (if applicable), and Player 4 is on the right (if applicable).  
3.1) Hotseat (Basic) Games
To start a Hotseat game (a game that involves one computer with all human players), one could just click “Begin Game.”  The default settings are set for a two-human player game (“Blue” vs. “Red”) with 10 walls and a 10x10 board.  To add additional players, click the check boxes next to Player 3 and/or Player 4.  When the box is checked, that player is activated, and their options can be set.  

Any names may be entered in the player name boxes.  If the player type is not set to “Human,” select the human player button located below the player name.  When ready, click “Begin Game” to start with the desired settings.
3.2) Games over Multiple Computers

If one user is playing another using multiple computers, one user will have to be designated as a “Host,” and the other(s) a “Client.”  The host will set up the game for all the players.  The client will type in the networking information to link up with the host.  The client must know the IP Address of the Host computer they are connecting to.
Instructions for “Host”:  To start a Network game, select “New Game” from the starting menu.  First, for any player slot, select “Human Player” or “AI Player” (see section 3.3) to represent the Host player.  To enter information for a Client player, select “Remote User” under another player slot.  The list box below “Remote User” should include a list of players attempting to connect to the Host machine.  The list should fill in as clients connect to the Host.  Select a client player from the list.  The information for that player slot fills in using the data the client entered for themselves.  The host can not change the name of the client player once selected.  The “Active” indicator should say “Yes,” meaning that that player has submitted their information and is at their computer.  If a Client player should be disconnected while the Host is entering information on the player setup screen, the Active” indicator will change to “No.”  The Host must either wait for the Client to reconnect, or they must choose a different player.  Once all client players have been declared and options have been specified, click “Begin Game” to start the game over the network.
Instructions for “Client”:  To connect with the designated Host, select “Join a Hosted Game” from the starting menu.  A screen asking for the client player’s name comes up.  Clients may only change their name before connecting – the Host is in charge of all other game settings.  Also, the Client must type in the Host’s IP address.  Once entered, click “Connect.”  The information will be sent to the Host, where they will use the submitted player information to set up the game.  A dialog box appears that asks to wait for the Host to finish setup.  At this point, the connection to the Host may be terminated by clicking “Disconnect.”  When setup is complete, the game board will appear and play will begin.
3.3) Games Involving AI Players
To start a game with AI’s created for the program, select “New Game” from the starting menu.  The player setup screen will come up.  First, for any one player slot, select “Human Player” to represent the human player.  To enter information for an AI player, select “AI Player” under another player slot.  Below “AI Player” should appear a “Find AI” button.  Click it, and locate an AI file on the computer.  Then click “OK.” The location of the AI will appear in the Location box below the “Find AI” button.  Once all AI players have been declared and options have been specified, click “Begin Game” to start the game over the network.
4.) Setting Up Saved Games
4.1) Hotseat (Basic) Games
To resume a Hotseat game previously saved, select “Continue Game” from the starting menu.  Locate and select the file containing the desired game log.  The board will be displayed with the status of the game before it was suspended.
4.2) Games Involving AI Players
To resume a game with AI’s previously saved, select “Continue Game” from the starting menu.  Locate and select the file containing the desired game log.  If the AI’s involved are still in the same file location, the board will be displayed with the status of the game before it was suspended.  If the AI’s used are missing from their previous file location, the player setup screen will come up and a new AI will need to be specified to take the place of the existing missing AI module.
5.) Playing the Game
5.1) Basics
After setting up the players, the program starts the game and displays the board.  The board starts with the settings specified on the player setup screen.  Player 1 appears in the bottom starting zone, Player 2 appears in the top zone, Player 3 is on the left (if applicable), and Player 4 is on the right (if applicable).  
By default, the game will start with Player 1.  Then the players take turns in their numerical order.  The current player’s turn is indicated by the highlighting of player information on the right of the screen.
On a player’s turn, they may move their token or place a wall.  After they do this, the next player continues this procedure, and so on.  On an AI’s turn, it has ten seconds to make a move, or else it will be disqualified.  After ten seconds, the results of the AI’s move will be displayed.  It should also be noted that in a network game, a player will be terminated and lose the game if they are disconnected from the network in any way.  A notification will be displayed to all players, and the defunct token will be removed from the board at the time of disconnection.
For the first token move, the player may choose any space on their edge of the board to move.  Once on the board, however, they may not move off the board except on the opposite side (goal zone).

5.2) Moving a Token
A player’s token may be moved either right, left, forward, or backward.  To move the token, simply click any highlighted space.  These are all legal possibilities for token movement.  
5.3) Placing a Wall
A player may place a wall anywhere on the board, covering two grooves.  Legal wall placements will be indicated by yellow lines on the grooves.  Yellow lines are displayed by hovering the mouse over the grooves on the board.  Placing the mouse over vertical grooves displays vertical lines.  Placing the mouse over horizontal grooves displays horizontal lines.  When a desired yellow line appears, click it, and a wall will be placed in that position.
5.4) Winning the Game
When a player has advanced their token to their target goal zone, that player has won the game.  A message will appear that will ask the player if he or she wants to play again.  If they select “Yes,” they will be taken back to the setup, as well as any other players on other computers.
5.5) Stopping a Game in Progress
Any player may either suspend or quit a game during play.  To quit without saving the progress, select “Quit Game” under the “File” menu.  The program will prompt if the game should be saved.  Click “No” to quit Quoridor.  If others are playing on other computers, a message will be displayed on their computers saying that a player has quit.  
To save the current state of the game, select “Save Game” under the “File” menu.  Then choose a location on the computer to save the log file for the game.  This file can be loaded by continuing the game at a later time (see Section 4).
6.) Creating AI’s for the Game
Coming this March.  Stay tuned!
7.) Additional Features
7.1) Wall Count
On the Player Setup screen, at the bottom, the number of walls may be decreased to as low as 0 or increased to as high as 144 by clicking the arrows to the side of the box.  
7.2) Board Size
On the Player Setup screen, at the bottom, the board size can be set from 6x6 to 12x12 by clicking the arrows to the side of the box.  
7.3) Game Logs
IDOT promises Game Logs this Spring…
7.4) Network Chat
More to come! 
7.5) Help Menu
All of the details mentioned in this document can be found interactively through the Help Menu located in the game.  Just click on “Help” then “Help Topics” to access the Help Menu.
8.) Glossary

AI (Artificial Intelligence) – refers to an algorithm that runs interactively to act as a logical sequence of actions as reflected by the actions of the human brain.

board – the square platform where tokens and walls are placed upon in Quoridor.

client – the designated players/computers that stand by as the host sets up and manages the game.

game – a session of play starting with tokens off the board and ending when any token reaches the other side of the board respective to its starting edge.

goal – colored zone on the edge of the board opposite from where a player starts.  A player must reach this area to win the game.

groove – the “lines” that dissect the board, forming spaces.

host – the designated player(s)/computer that are responsible for setting up the game for all other players on different computers, referred to as “clients.”

hotseat – gameplay involving only one instance of a Quoridor game with 2 to 4 players.
jump – refers to the moving of a token past another token one unblocked space to any side of the other token.

local player – a player (human or AI) contained on a computer and not over the network.
move – a player moving from one square on the board to another square.
player – any entity interacting with the board game – can be a live person or an AI module.

remote player – a player (human or AI) contained on a computer over the network.
space – an individual square surrounded by grooves on the game board.

token – a game piece representing the player’s current position on the board.

turn – the procedure in which a player can move their token, place a wall, or pass their turn.

wall – a physical blockage which prevents players from moving across the groove where one is placed.  Walls in Quoridor and in our implementation block two adjacent spaces in a line.

wall placement – placing of a wall in a valid location on the board.
9.) Contributions

Todd Astroth – Wrote User Manual (initial content)
Chris Cobb – Edited text for content and continuity
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